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to suit different people and, most of all; we aim to make training fun!”

Shelley and her team have worked hard to achieve accreditation by the Learning and Performance Institute 
for the IT Training Surgery, as a recognized high quality provider of IT training,

To find out more about our training give us a call on 020 8203 1774 or visit our website  
www.theittrainingsurgery.com

Download free eBooks at bookboon.com

file:file:///C:/Users/User/Dropbox/Bookboon/Excel%25202013/www.theittrainingsurgery.com


Excel 2016 Core Part One

11 

About Excel 2016 Core Part One


About Excel 2016 Core Part One
This user guide will take you through all the things you need to know when using Excel at a simple level.

You will learn how to:

•	 Get around Excel 2016
•	 Add text and numbers to spreadsheets
•	 Use Autofill to copy formula and create series
•	 Create a basic formula
•	 Use Average Minimum and Maximum
•	 Work with Worksheets
•	 And much more
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1	 First things first
1.1	 Starting Excel

Excel 2016 can be started from the Start Screen, the desktop or the Task Bar.

1.1.1	 The Start Screen (Windows 8.1)

Figure 1 – Windows 8.1 start screen

Click or Tap (if you are using a touch screen) on the Excel Tile.

1.1.2	 The Start Screen Windows 10

Figure 2 – Windows 10 start screen

Click or Tap (if you are using a touch screen) on the Excel Tile.
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1.1.3	 The Desktop

Figure 3 – Desktop shortcuts

Click on the Desktop Icon to launch Excel 2016.

1.1.4	 The Task Bar

Figure 4 – Taskbar shortcuts

Click on the Excel Icon on the Task bar to launch Excel 2016.

1.2	 The Excel Window

The Excel Window is arranged with the title of the workbook along the very top edge, the Quick Access 
Toolbar top left, the Minimize, Maximize and Restore icons top right and a grid in the middle, with 
vertical and horizontal scroll bars.

Figure 5 – The Excel window

Download free eBooks at bookboon.com



Excel 2016 Core Part One

14 

First things first


1.3	 The Ribbon

The Ribbon sits across the top of the screen and is made up of several Tabs. Each Tab is arranged in 
groups and each group consists of icons that go together.

1.3.1	 The Home Ribbon

Figure 6 – The Home Ribbon

Here you will find the most common icons – all about formatting adding rows and columns, editing 
and finding things.

1.3.2	 The Insert Ribbon

Figure 7 – The Insert Ribbon

Add a Pivot Table, Pictures, Charts and Shapes here.

1.3.3	 The Page Layout Ribbon

Figure 8 – The Page Layout Ribbon

Change the way the page is laid out using the icons on this Ribbon, Margins, Orientation and Scaling.

1.3.4	 The Formulas Ribbon

Figure 9 – The Formulas Ribbon

The Formulas Ribbon has categories for all the formulas in Excel and this is where you will find Auditing 
and Named Ranges.
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1.3.5	 The Data Ribbon

Figure 10 – The Data Ribbon

If you want to Sort, Filter, Subtotal, analyze or bring data in from other sources – the Data Ribbon is 
where you want to be.

1.3.6	 The Review Ribbon

Figure 11 – The Review Ribbon

Here you can Spell check, Translate, add Comment and Review the workbook with others.
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1.3.7	 The View Ribbon

Figure 12 – The View Ribbon

Change the way you are viewing the workbook here and customize what you are looking at.

1.4	 Customizing the Quick Access toolbar

The Quick Access Toolbar is one of the most useful things in Excel. There is also a version of it for each 
of the Office packages so you can apply this lesson to Word, Excel, PowerPoint and Outlook.

The Quick Access Toolbar is situated at the top left of the screen above the File menu. It holds shortcuts 
that you use frequently. When you first load up Excel there are only a few icons on the Quick Access 
Toolbar. You can customize the toolbar with the icons that you use most frequently.

The Quick Access Toolbar can be moved to sit below the Ribbon which then gives you plenty of space 
to keep adding icons.

1.4.1	 The Quick Access Toolbar at first

Figure 13 – New Quick Access Toolbar

Here is the Quick Access Toolbar when you first load up Excel. The only icons are

•	 Save
•	 Undo
•	 Redo
•	 Touch – this changes the Ribbon giving more space between icons for use with a touch device
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1.4.2	 Adding Icons to the Quick Access Toolbar

Figure 14 – Add icons to the Quick Access Toolbar

Click the drop down arrow on the right of the Quick Access Toolbar and select from the list of frequently 
used icons. Whatever you select will be added to the toolbar.

•	 If you would like the Quick Access Toolbar to be shown below the Ribbon pick this option
•	 For more shortcuts click More Commands

1.4.3	 Add an Icon with Right Click

Figure 15 – Add icon with Right Click

When you find an icon that you use all the time, you can save yourself a little time by adding it to the 
Quick Access Toolbar using the Right Mouse button.
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1.4.4	 More Commands

Figure 16 – Find more commands

There are hundreds of icons in Excel that can be added to the Quick Access Toolbar. As we all work 
differently we will have different requirements.

•	 Click the Drop down to the right of the Quick Access Toolbar
•	 Select More Commands
•	 Now you can choose from the different selections of icons available.

1.	 Here is a drop down list of different categories of icons, have a look through what is available.
2.	 The column on the Left shows the available icons in the category displayed – double click an 

icon to move it across to the Right hand column
3.	 The column on the Right shows the icons currently on the Quick Access Toolbar 
4.	 You can move the icons up and down the order with these spinners
5.	 Click OK when you are done
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1.4.5	 Show below the Ribbon

Figure 17 – Show the Quick Access Toolbar below the Ribbon

Here I have clicked Show Below the Ribbon and added the New document icon and the Print Icon.

1.4.6	 Remove an icon from the Quick Access Toolbar

Figure 18 – Remove icon from Quick Access toolbar

If it is one of the frequent Icons, you can remove the tick from the drop down list and the icon will be gone.

1.4.7	 Right Click to remove an Icon

Figure 19 – Remove an icon with a right click

Just like adding, you can also right click to remove an icon from the Quick Access Toolbar.
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1.4.8	 Use More Commands to Remove an Icon

Figure 20 – Remove via more commands

1.	 Select the icon you wish to remove in the right hand column
2.	 Click Remove
3.	 Click Ok
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1.5	 Customizing the Ribbon

In Excel 2016 it is now possible to customize the Ribbon itself. This means you can have a whole ribbon 
tab with your own icons and groups of icons, or you can just change one of the pre-set Ribbon tabs to suit.

1.5.1	 Customize the Ribbon

1.	 Click File
2.	 Click Options
3.	 Click customize the Ribbon

Figure 21 – Excel Options

Figure 22 – Customize Ribbon Options

You now have two columns, on the left are the available icons that can be added to the Ribbon (1)
On the right are the different Ribbon tabs (2) and groups of icons (3).

You can choose commands from the list of Popular Commands or from one of the other drop down options.
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1.5.2	 Create A New Group On an Existing Ribbon Tab

Figure 23 – Create a new group of icons

1.	 Click on the Ribbon you wish to customize
2.	 Click New Group
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1.5.3	 Rename the new group

Figure 24 – Rename a group of icons

1.	 Select the New Group (Custom)
2.	 Click on Rename
3.	 Type in your new name
4.	 Click OK

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/academictransfer


Excel 2016 Core Part One

24 

First things first


1.5.4	 Add Icons to The New Group

Figure 25 – Add more icons

1.	 Click on the icon you want to add from the list on the left
2.	 Click Add
3.	 The icons now appear in the group you selected

When you have finished adding icons, click OK to go back into Excel.

1.5.5	 See The Group On the Ribbon

Figure 26 – See the new group on the Ribbon

My new group Columns and Rows is now on the far right of the Home Ribbon.

This means that you can customize one or two Ribbon Tabs with your favorite icons and then they are 
always there at your fingertips.
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1.5.6	 Create a new Ribbon Tab

Figure 27 – Create a new Ribbon tab

If you wish to create a brand new Ribbon Tab rather than modify an existing one, click New Tab.

1.5.7	 Rename the Tab

Figure 28 – Rename the tab

Click on the New Tab (Custom)
Click on Rename
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1.5.8	 Type a Name for The New Ribbon

Figure 29 – Type in the name

Type in the name
Click OK
Then rename the New Group (Custom) as above

1.5.9	 Now Add Icons to The New Ribbon and Group

Figure 30 – Build tab up with icons

Find the icons you want and add them to the group you renamed – I am adding my favorite Sorting 
and Subtotal features.
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1.5.10	 See your new Ribbon

Figure 31 – Here is the new Ribbon tab

Here is my new Ribbon.

1.5.11	 Moving Tabs around

Figure 32 – You can move the ribbon tabs around to suit you

1.	 Click on the Ribbon you wish to move
2.	 Click the Move Up button or the Move Down Button
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1.5.12	 Remove a tab

Figure 33 – Remove a tab 

1.	 Click on the tab you wish to remove
2.	 Click Remove
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1.6	 Using Zoom

When working with a large worksheet, you may not be able to see everything on your screen. This is 
because when maximized to 100% many worksheets are larger than the screen. To view more or less of 
the detail you need to use the Zoom tools.

1.6.1	 Zoom Slider

Figure 34 – Zoom slider

The Zoom slider sits at the bottom right of the screen. To change the magnification drag the slider right 
to enlarge and left to reduce. You can also click on the plus and minus signs.

1.6.2	 Show the Zoom dialogue box

Figure 35 – Zoom dialogue

Click on the 100% which is in the bottom right corner
The Zoom box will appear where you can change the magnification or fit selection.
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1.6.3	 Use the Zoom group on the View Ribbon

Figure 36 – The Zoom group

Zoom – this opens up the Zoom dialogue box
100% – returns the worksheet to 100% magnification if you have changed it
Zoom to Selection – this will zoom the current selection in view

1.7	 Assigning shortcut keys using The Alt Key

Office 2013 including Excel 2016 comes with built in keyboard shortcuts that you access via the Alt Key. 
Press the Alt Key and some letters and numbers pop up on screen. Now press those letters and numbers 
in sequence and you have a keyboard shortcut.

However, if you wish to create your own keyboard shortcut you can add your shortcut to the Quick Access 
toolbar and then when you hit Alt, a number appears – hey presto you just customized a keyboard shortcut.

1.7.1	 Add Your Icon to The Quick Access Toolbar

Figure 37 – Add to Quick Access Toolbar

Right click and then click on Add to Quick Access Toolbar.

1.7.2	 Here is my Quick Access Toolbar

Figure 38 – New additions are added to the right

My new addition shows up on the far right in position number 8.
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1.7.3	 Press Alt

Figure 39 – Use the Alt key to get the visual shortcuts

When I press the Alt Key – the numbers which indicate the position of the icon on the Quick Access 
Toolbar appear.
Now to use my Subtotal icon I just press 8.
So Alt + 8 is my new keyboard shortcut for Subtotals.
Alt + 1 would be Save, Alt +2 would be Undo etc.
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1.7.4	 Change the order

Figure 40 – Change the order of the icons

1.	 Click File
2.	 Click Options
3.	 Click customize the Quick Access Toolbar
4.	 In the list on the right, select the icon you wish to move up or down
5.	 Click on the Move Up or Move Down arrows to change the position

1.8	 Adding values to workbook properties

Workbook Properties allow you to add information about the Workbooks. Add an Author, a Title, Tag 
the workbook so that it can be found easily.

1.8.1	 Where do I find Properties?

Figure 41 – The Workbook Properties

Click on File and then see Info
Properties are on the right
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1.8.2	 Add an Author

Figure 42 – Adding an Author

You can type the name of another person to have them the Author or you could pick them from a list 
in the address book.

Properties will show you when the document was first created, last printed or modified and who the 
Author is.

1.8.3	 Advanced Properties

Figure 43 – Show advanced properties
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1.9	 The Advanced Properties Dialogue box

Figure 44 – Fill in the box in Advanced Properties
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2	 Saving
2.1	 Saving a Workbook for the First Time

There are several ways to save your work in Excel 2016. The icon on The Quick Access Toolbar, The File 
Menu and the Keyboard.

2.1.1	 Saving your workbook for the first time

When you save the workbook for the first time, you will be prompted for the location you wish to save 
in and for the name of the workbook.

2.1.2	 Save a Workbook Quick Access Toolbar Method

Figure 45 – The Save icon

Figure 46 – Choose save location

In Excel 2016 you will see a list of all the available locations that you can save to. Whether they are 
Online locations or locations on your PC.
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1.	 Click the Save Icon on the Quick Access Toolbar
2.	 Then navigate to the folder you wish to save in
3.	 Type a name for the workbook
4.	 Click Save

2.1.3	 Save using the Keyboard

Press Control + S

This keyboard shortcut will save the workbook just like clicking on the icon. You will be prompted in 
the same way.

2.1.4	 Saving with File As

Figure 47 – Save as – use this to choose a different location or save a copy

1.	 Click File
2.	 Click Save As
3.	 Click This PC
4.	 Select the folder from the list on the right
5.	 If you cannot see the folder you want to use, you can click Browse to navigate to the one 

you want
6.	 Type a name for the workbook
7.	 Click Save

2.2	 Saving Your Workbook Once It Has A Name

When you save a workbook that has already been saved before, all you are saving is any work you have 
added to it, since it was last saved.

You can use any of the Save options to save your work. Use the Save Icon, Control + S or File -Save As.

If you want to save a copy of your workbook in another location, then you will need to use File and Save 
As so that you can pick the folder where you wish to save the workbook.
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2.3	 Save as different file formats

Most of the time, you’ll probably want to save your workbooks in the current file format (.xlsx). Although 
sometimes you might need to save your spreadsheet as a PDF, a text file or an XPS file. Bear in mind 
that if you save your spreadsheet in another format, some data and features might not be supported and 
so will not be saved.

If you need to save your work in a format that an older version of Excel can open, then any features 
which are new in Excel 2016 may not be available in the older version.

2.3.1	 Save As

1.	 Click File
2.	 Click Save As
3.	 Navigate to the folder location you wish to save in
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2.3.2	 Decide On the Type of File

Figure 48 – Select the file type

1.	 Click Save as type
2.	 Select the type of file you wish to create
3.	 Type a name for your file
4.	 Click Save

2.4	 Saving Files to remote locations

Office 2016 is a standalone product and also part of Office 365. You can save your files to different 
locations apart from your local computer or your workplace network.

Office 365 comes with Onedrive for Business and Sharepoint. If you are using a stand-alone version of 
Office and you have a Windows Live or Microsoft Account you also have a personal One Drive storage 
location in the cloud.

2.4.1	 Save to OneDrive

Figure 49 – Save to OneDrive
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1.	 Click File
2.	 Click Save As
3.	 Select the OneDrive
4.	 Then select the folder to save in
5.	 Name and save

2.4.2	 Save to SharePoint

Figure 50 – Save to SharePoint

1.	 Click File
2.	 Click Save As
3.	 Click on the SharePoint icon with the organization’s name
4.	 Select the folder to store in from the recent folder or click Browse to find the folder to save in

2.4.3	 Save To Your Personal Folder on The SharePoint Site

Figure 51 – Save to your personal folder – OneDrive for Business
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Click on File and then Saved as
Then select the OneDrive@theittrainingsurgery folder with your name in my case  
shelley.fishel@theittrainingsurgery.com
Then navigate to the folder you wish to save in.

2.5	 Maintaining backward compatibility

When newer versions of Office programs come out, there is new functionality which is not available 
in the older versions. Specifically, if you are working with someone who is still using Office 2003 then 
you will have issues as the file format changed with Office 2007 which is the release after 2003. In later 
versions new features keep being added so it becomes necessary to save the workbook in a 2003 friendly 
way. This is called Compatibility Mode.

You can set your workbooks to be saved in this mode all the time – beware though you will lose 
functionality. Or you can save workbooks individually if you know you need to send them to someone 
with the older version.
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2.5.1	 Compatibility Mode

Figure 52 – Keep compatibility with older versions

When you have a file that has been saved in compatibility mode it will tell you at the top of the screen.

2.5.2	 To save in Compatibility Mode

Figure 53 – Save in compatibility mode – choose Excel 97-2003

1.	 Click File
2.	 Click Save As
3.	 Navigate to the folder you wish to save in
4.	 Type a name for your file
5.	 Change the Save as type to Excel 97-2003 workbook
6.	 Click Save
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2.5.3	 Save all f﻿iles in Compatibility Mode

Figure 54 – Select the file type for all files 

1.	 Click File
2.	 Click Options
3.	 Click on Save
4.	 Change the Save files in this format box to Excel 97-2003 
5.	 Click OK

Whenever you save a workbook it will be saved in Compatibility Mode once you change this setting.

2.5.4	 Convert an Excel 97-2003 file to a later version

Figure 55 – Convert to latest version

If your file is in Compatibility Mode, you will see the Convert button in the Backstage View.

1.	 Click File
2.	 Click Convert

Note the explanatory text that mentions that the file will be converted and that this may result in 
layout changes. 
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3	 Backstage view
3.1	 The Backstage View

The backstage view is the menu that shows up on the left of the screen when you click on the File menu. This 
is where you will find shortcuts for Information about the current file, Save shortcuts, Options and more.

3.1.1	 The Backstage View – Showing the Info Panel

Figure 56 – Backstage in Excel 2016
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Click on the File Menu

You are now in the Backstage View – in the image above, you can see the Info screen showing:

•	 Protect Workbook – Control what people can change and what they cannot change when 
you send them your workbook

•	 Check for Issues – Check if there is anything in the workbook that will stop it performing at 
its best and check for compatibility issues here

•	 Mange Workbook – recover unsaved versions of the workbook, check the workbook in or 
out if you are working with a shared file.

•	 Browser View Options – control how your workbook will behave when displayed in a 
browser on a SharePoint site

•	 Properties – set the Properties for the workbook, such as Author, or see when it was created 
and edited

3.2	 Excel Options

To make changes to many of Excel’s options you will need to get into the Options panel. Here you 
can change:

General Options – default font, what you can see etc
Formulas – how Excel calculates and other things pertaining to how Formulas work
Proofing – Auto Correct Options and what Spell Check should look out for
Save – the file format to save in, where auto saves are kept, how Auto recover works
Language – set the language here
Advanced – Editing options, more options than there is room for here!
Customize Ribbon – here you can customize the Ribbon and create new Ribbon Tabs.
Quick Access Toolbar – customize the Quick Access toolbar here
Add Ins – View and Manage Add Ins – extra programs that compliment Excel
Trust Center – control privacy settings
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4	 Share the workbook with others
When working in a team or collaborative environment, you will inevitably wish to share your workbook 
with others in some way.

You can: 
•	 Share with People
•	 Email
•	 Present Online

Figure 57 – Share your work with others

4.1	 Share with People

Sharing with others within your organisation and who are using Office 365 can be done in two ways, 
from the File – Share menu or direct from within the workbook itself.

4.2	 Share with People via File Menu

Figure 58 – Invite others to your workbook

Download free eBooks at bookboon.com



Excel 2016 Core Part One

46 

Share the workbook with others


1.	 Click the File menu
2.	 Click on Share with People
3.	 Click the Share with People button
4.	 The share pane opens on the right of the spreadsheet

Figure 59 – Type the email address to share with 
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4.3	 Share with People from within the workbook

Click the Share icon at the top right of the screen

Figure 60 – Invite from within

The Share Pane will open – fill in as in the instructions above.

4.4	 Share Via Email

When working in Excel you may need to share your workbook with someone who is not on your team, 
a client or a colleague. In this instance you may wish to email the workbook/spreadsheet or send it for 
shared review. You might also wish to Present it on line or invite others to share it with you.

4.4.1	 Share Via Email

Figure 61 – Share via email – choose to send as attachment or to share the workbook on line
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1.	 Click the File Menu
2.	 Click Share
3.	 Select Email
4.	 Then decide which option you wish to use

•	 Send as Attachment – starts up Outlook and attaches the workbook to a new email message
•	 Send a Link – starts up Outlook and puts a link to the file in the body of the message
•	 Send as PDF – you can send your workbook as a PDF even without a pdf program on your 

machine, so pick this one if that is the case for you
•	 Send as XPS – XPS is a document file format that allows you to save your documents/

spreadsheets electronically and once saved, you cannot edit them – just like once you have 
printed a piece of paper you cannot change what is printed. You can send your spreadsheet 
as an XPS file. The person who receives it will need an XPS viewer to be able to  
read the document

•	 Send as Internet Fax – you can send your document via Internet Fax – however you will 
need a Fax Service Provider to do so

4.5	 Open a Shared Workbook

When you receive an email telling you that a colleague has shared a workbook with you, you will want 
to open it. There will be a link in the email. When you click on the link. the workbook will open up in 
a browser.

4.5.1	 Open a Shared Workbook from a link

Figure 62 – Open a shared workbook 

Click on the name of the file which is in light blue big letters.

You may need to request permission to access the file. This will depend on the permissions that your 
administrator has set up. If there are no sharing restrictions, then the file will open up in the browser 
as shown below.
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If there are restrictions, you may have to request permission. As soon as you do, an email goes to the 
originator of the shared file asking them to approve. Once they have approved you will receive another 
email telling you that you can now go to the document.

4.5.2	 The Shared Workbook

Figure 63 – Workbook opens in the browser in Excel Online

The workbook opens up in a web browser using Excel Online.

4.5.3	 Edit in Excel or Edit in Web App

Figure 64 – Choose to edit online or in Excel

Edit the workbook in the Excel Web App on line or launch the full Excel Application on your desktop.

This workbook is in a shared location and can be worked on by only one person at a time.
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5	� Create Worksheets 
and Workbooks

5.1	 Creating new blank workbooks

In Excel 2016 data is added to Worksheets, which in turn live inside Workbooks. Workbooks can be 
made up of just one single worksheet or of many. You can add and delete worksheets from a workbook 
quite easily.

5.1.1	 To create a new blank workbook from the Start screen

Figure 65 – Create a new blank workbook
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1.	 Click on the Excel shortcut on either your desktop, the task bar, the Windows Start screen 
or the Start menu

2.	 A window like the one in the picture will pop up.
3.	 Click on Blank Workbook

5.1.2	 A new blank workbook using the keyboard

When you are in Excel, you can start a new workbook by pressing the Control key and the letter N to 
create a new workbook
Control + N

5.1.3	 Create a New workbook from the Quick Access Toolbar

Figure 66 – Create a new workbook from the shortcut icon

If you have the icon for New Workbook on the Quick Access Toolbar, simply click on it to create a 
new book.

5.1.4	 Create a new Workbook from the File Menu

Figure 67 – Create a new workbook from the file menu

1.	 Click the File Menu
2.	 Click new
3.	 Select Blank Workbook
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5.2	 Creating New Workbooks Using Templates

Excel comes with many built in templates which can speed up your editing time.

5.2.1	 Create A Workbook from A Template

Figure 68 – Create from template

1.	 Click File
2.	 Click New
3.	 Select the template you want to use from those displayed

5.2.2	 Search for A Template

In Excel 2016 you can search for many more sample templates on line if the local ones do not meet your 
needs. I want to create an Invoice template:

Type Invoice into the search bar and then press Enter or click the magnifying glass – a list of templates 
that match your search are displayed along with many categories on the right of the screen.

Figure 69 – Search for a template

Click on the one you want to use.
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5.3	 Changing worksheet order

If the worksheets in your workbook are not in the right order, you can drag and drop them into the 
order you need.

5.3.1	 Move worksheets around

Figure 70 – Move worksheets around by dragging

I would like to place the Coffee Sales worksheet at the front of the tabs

1.	 Click and drag – you will see a little arrow and a picture of a page 
2.	 Drop the worksheet in the location you require.

Hey presto!
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5.4	 Move or copy to a different workbook

1.	 Right click on the sheet tab you wish to move or copy
2.	 Click on Move or Copy 
3.	 In the dialog box that pops up select where you want to move the worksheet to (this is 

which of the open workbooks you want to use)
4.	 Select where you want the worksheet within the workbook 
5.	 If you want a copy, tick the Create a copy box 
6.	 Click OK

Figure 71 – Move or copy on a right click

5.5	 Set how many worksheets you start with

If you always need more than one worksheet when starting a workbook, you can set Excel Options to 
start up a workbook with as many as you need.

5.5.1	 Set start up options

Figure 72 – Get to options from the File menu

1.	 Click File
2.	 Click Options
3.	 Set number of worksheets
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Figure 73 – Set the number of worksheets to start with

4.	 Change – Include this many sheets to the number you require (I have set it to 3 sheets here)
5.	 Click OK

5.5.2	 New workbook now has three worksheets

Figure 74 – Your new settings take effect

5.6	 Importing a .CSV file

In Excel 2016 you can import files from different applications and in different formats into Excel.

5.6.1	 Import a CSV file

Figure 75 – Importing a .csv file is simple
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CSV stands for Comma Separated Values and is normally a list that has been created via the web or 
saved from Excel so that it can be imported into another type of program.

1.	 Click File
2.	 Click Open
3.	 Navigate to the file you wish to open
4.	 Select it 
5.	 It will open in Excel!

Note that it has a different looking icon with an a on the image. This shows it is not a normal Excel file 
although it will open and you can work on it in Excel as normal.
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6	 Adding data
6.1	 Adding Text

Figure 76 – Add text to the worksheet

1.	 Click on the cell
2.	 Type the text 
3.	 Press enter

6.2	 Adding Numbers

Figure 77 – Add numbers to the worksheet

1.	 Click on the cell
2.	 Type the number (s)
3.	 Press enter
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6.3	 Moving Around a Spreadsheet

6.3.1	 Moving around using the keyboard

Keyboard Characters What they do

↑ Up one cell

↓ Down one cell

← Left one cell

→ Right one cell

Control → Goes to the far right of a column

Control ← Goes to the far left of a column

Home Goes to Column A of the row you are in

Control + Home Goes to cell A1 no matter where you are

Control + End Moves to the bottom right of the area you have typed

Page Up Moves the active cell up one screen

Page Down Moves the active cell down one screen

6.4	 Cursor Shapes (Mouse Shapes)

6.4.1	 The Cursor Shapes

Figure 78 – Mouse cursor shapes
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6.5	 Selecting Data in a Worksheet

6.5.1	 Selecting A Range Of Cells

Figure 79 – Select a range by dragging

1.	 Start from the cell at the top left hand corner of the area you wish to select
2.	 Make sure that your mouse looks like the big plus sign
3.	 Click and drag over the cells you require
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6.5.2	 Selecting Columns

Figure 80 – Select a column

Click on the Column letter you require
Or
Click and drag over the column letters to select several columns

Figure 81 – Drag over more column headings to select more columns

6.5.3	 Selecting Areas Which Are Not Next to Each Other

Figure 82 – Use the Control key to select areas not next to each other

1.	 Select the first area you require
2.	 Hold down the Ctrl key on the keyboard
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6.5.4	 Selecting the whole sheet

Figure 83 – Select the whole worksheet

Click on the square at the top left corner of the spreadsheet – it has a diagonal arrow in it pointing at 
the sheet. This will select everything!

6.5.5	 Selecting a Row

Figure 84 – Select a row by clicking on the row number

Click on the row number
If you wish to select several rows, click and drag over the numbers, if they are not next to each other 
you can use the Control Key.
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7	 Navigating your Workbook
7.1	 Searching for data within a workbook

At Coffee Island Bill the new manager needs to find Lisa Jones in the client list.

7.1.1	 Find Information in A Worksheet

Figure 85 – Find something in the worksheet

1.	 On the Home Ribbon 
2.	 Click the drop down and select Find

7.1.2	 Type in your criteria

Figure 86 – Find Lisa

Click Find All.
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Figure 87 – Find all finds all instances of the item you typed

The Find function has found all instances of Lisa – in the First Name field, the email address fields and 
the list of names in column G. You can see a list of the values in the lower part of the results. As you 
can see from the drop down under Find, there are many different things you can Find in a worksheet or 
even a workbook. Look for simple text or numbers, a date, data that has been formatted in a particular 
way, where conditional formatting has been applied, even formulas.
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7.2	 Inserting hyperlinks

You can create links to other worksheets within a workbook or to an external place such as a website 
directly from within an Excel Worksheet. Hyperlinks can help you to create a menu to navigate between 
different worksheets and workbooks.

7.2.1	 Add a hyperlink to another worksheet

Figure 88 – Insert a hyperlink

First type the text that will be the hyperlink – I have typed Coffee Sales as I will link to that worksheet.
Select the cell and then on the Insert Ribbon.
Click Hyperlink

7.2.2	 Select where to link to

Figure 89 – Choose where the hyperlink goes

1.	 Select whether the hyperlink is a Place in This Document (I am linking to another worksheet)
2.	 Type the text you want the Hyperlink to display (this is what will show on the worksheet) I 

have typed this on the worksheet, did not need to retype it here.
3.	 Type in the cell reference you wish to start from on the sheet you have linked to
4.	 Click OK
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7.2.3	 Click on The Hyperlink

Figure 90 – Click on the hand and off you go

Simply hover the mouse over the linked text – it turns into a hand
Click and you will be taken to the location you selected

7.2.4	 Hyperlink to Another Workbook

Figure 91 – Open another workbook via a Hyperlink

1.	 Click Insert Hyperlink as before
2.	 Type the text to display on the worksheet
3.	 Select Existing File or Web Page 
4.	 Tell Excel where to look for the file you wish to open 
5.	 Select the file you wish to open 
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Figure 92 – Shortcuts from one worksheet or workbook to another

I now have a shortcut direct to the other file – you can see in the picture that the path is displayed.

7.2.5	 Add a Hyperlink using the keyboard

Press Control + K to open the Add Hyperlink dialogue box

Then proceed as above.
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7.3	 Using Go To

Now Bob the new manager of Coffee Island needs to locate the data in a particular cell in the worksheet. 
He can use the Go To shortcut to do this. There are two ways to access Go To – via the Home Ribbon 
Find menu icon or the keyboard.

7.3.1	 Go To via the Keyboard

Press the F5 key on your keyboard
The F-Keys are the function keys along the top of the keyboard. If you are using a laptop then they may 
have little blue white or red symbols on them. These are shortcuts and become active when you press 
the Fn key (bottom left of the keyboard).

Figure 93 – Go To using the Keyboard 

1.	 Type the cell reference into the box
2.	 Click OK
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7.3.2	 Go To with the Mouse

Figure 94 – Go To using the Mouse

1.	 On the Home Ribbon
2.	 Click Find & Select
3.	 Click Go To

You will get the same dialogue box as by using the Keyboard so just type in the cell reference you wish 
to jump to.
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7.4	 Using the Name Box to Navigate

The Name box lives at the top of the screen underneath the Ribbon and to the left of the Formula Bar. 
The Name will always show you the cell reference of the cell you currently have your cursor in, and it 
very handy when you are looking at say row 149 and column AB. If you have scrolled that far, your 
cursor may have been left in cell A1, then when you type you will be typing in cell A1. Not great if you 
meant to type in cell AB149!

7.4.1	 The Name Box

Figure 95 – The Name box

Here you can see the Name Box and it shows cell D3 which is the cell where my cursor is currently sitting.

7.4.2	 Use the Name Box to Move Around

Figure 96 – Use cell names to navigate around 

If you know the cell reference you wish to move to, you can type it into the Name box and Excel will 
jump you there.
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8	 Workbook Views
8.1	 Introduction to Views

The Excel View options allow you to view or see the spreadsheet differently. You can adjust the Excel 
window to suit what you are currently working on by changing the view to match your current task.

Excel offers four different views:

1.	 Page Layout – displays worksheets as they would appear if you printed them out
2.	 Page Break Preview – displays the page breaks as blue lines 
3.	 Normal – normally use this view for building and editing worksheets.
4.	 Custom Views – This option enables you to set up the screen as you like it and see that view at 

the click of a button. A custom view can include hidden rows and columns and print settings.

Figure 97 – Workbook view icons – the view menu and the icons bottom right of the screen

8.1.1	 Normal View

Figure 98 – Normal view

In Normal View the spreadsheet is arranged in columns and rows and it is only possible to see the cells. 
Headers and Footers are not visible. Page breaks are only visible as dashed lines once the data has been 
viewed in Page Layout View.
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8.1.2	 Page Layout View

Figure 99 – Page Layout View – shows the margins and how it will look printed 

In Page Layout View visible elements are:

1.	 Rulers – Horizontal and Vertical
2.	 Header and Footer area
3.	 Margins
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8.1.3	 Page Break Preview

Page break preview comes into its own when you have a lot of information on your spreadsheet and then 
when you print, you end up with a few extra rows or columns printing on a separate page. 

Using Page Break Preview, you can adjust the page breaks and scale the spreadsheet so that it prints off 
on fewer sheets.

8.1.4	 To see Page Break Preview

Figure 100 – Page break preview icon on the View Ribbon

Click on the View Tab and then Page Break Preview.

OR

8.1.5	 Click the page break preview icon

Figure 101 – Page break preview icon from the bottom right of the screen

Download free eBooks at bookboon.com



Excel 2016 Core Part One

73 

Workbook Views


8.1.6	 See the Page Breaks

Figure 102 – Now you can see the page breaks

1.	 Drag dashed lines to move rows or columns to adjacent pages
2.	 Drag the solid line to change the actual page break
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What happens when I drag the dashed lines?

In effect you are scaling the text on the page and making it smaller so that it fits on to an A4 page (or 
whatever paper size you have selected).

8.2	 Page Breaks

Page breaks allow you to control where one page ends and the next one starts. Excel will decide where 
the page breaks depending on how much information you have typed in and the size of the paper plus 
the margins. If, however you want to print your spreadsheet out in a particular way, you can set the 
page breaks up yourself.

Figure 103 – Insert a new page break where you wish

A page break will be added above the cell you are in and to the left. So if you select a cell in Column A, 
the page break will be inserted above. However, if you have your cursor in say Cell B4, Excel will insert 
one-page break above row 4 and one to the left of column B. So be careful where you place the cursor!

8.2.1	 Apply a Background

It is possible to format the background of your spreadsheet with an image.

Figure 104 – Apply a background to your worksheet
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When you click the Background icon you can choose from the following locations to get your image:

•	 From a file – you may want to have your logo feature as a background image – pick from file
•	 From SharePoint – if your images are stored in SharePoint you will need to look here
•	 Bing Image Search – you can trawl the internet for a suitable image – just beware of copy 

write issues
•	 Facebook – if your Microsoft Account is connected to Facebook you can select from an 

image you have stored there
•	 If you have a Flicker Account – you can grab an image from here

8.3	 Creating Custom Views

You can use a custom view to save specific display settings (such as column widths, row heights, hidden 
rows and columns, cell selections, filter settings, and window settings) and print settings (such as page 
settings, margins, headers and footers, and sheet settings) for a worksheet so that you can quickly apply 
these settings to that worksheet when needed.

8.3.1	 To create a Custom View

1.	 On a worksheet, change the display and print settings that you want to save in a custom view.
2.	 On the View tab, in the Workbook Views group, click Custom Views
3.	 Click Add.

Figure 105 – Custom views save your view settings
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4.	 In the Name box, type a name for the view
5.	 Under Include in view, select the check boxes of the settings that you want to include
6.	 Click OK

Figure 106 – Name the view

8.3.2	 To apply a Custom View

1.	 On the View tab, click on the Custom Views button
2.	 In the dialog box, select the name of the View you want to apply
3.	 Click Show

Figure 107 – Apply the view

8.3.3	 To delete a Custom View

1.	 On the View tab, click on the Custom Views button
2.	 In the dialog box, select the name of the View you want to delete
3.	 Click on Delete
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9	 Working with Data
9.1	 Cut and Paste

When you cut something and paste it elsewhere you are moving it from one location to another.

Figure 108 – Cut and paste

Use either the icons, a right click or the keyboard.
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1.	 Select the cells you wish to move
2.	 Go to the Home tab on the ribbon
3.	 Go to the Clipboard group
4.	 Click on the Cut icon Or
5.	 Press Ctrl-X Or
6.	 Right click and select Cut
7.	 Place your cursor in another location
8.	 Click on the Paste icon Or
9.	 Press CTRL-V Or

10.	 Right Click and select Paste

9.1.1	 Copy and Paste

Figure 109 – Copy and paste

1.	 Select the cells you wish to copy
2.	 Go to the Home tab on the ribbon
3.	 Go to the Clipboard group
4.	 Click on the Copy icon Or
5.	 Press Ctrl-C Or
6.	 Right Click and select Copy
7.	 Place your cursor in another location
8.	 Click on the Paste icon Or
9.	 Press CTRL-V Or

10.	 Right Click and select Paste
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9.1.2	 Copy by dragging

Figure 110 – Hold down Control when you drag to create a copy

1.	 Select the cells you wish to copy
2.	 Position your mouse at the border of the selection so that it changes to a cross arrow
3.	 Hold down CONTROL on the keyboard
4.	 A plus sign (+) will appear next to the cross arrow
5.	 Click and drag the selection to its new location	

9.1.3	 Move by dragging

Figure 111 – Drag the cell to another positon

1.	 Select the cells you wish to move
2.	 Position your mouse at the border of the selection so that it changes to a cross arrow
3.	 Click and drag the selection to its new location
4.	 The selection will move to the new location

9.2	 Using Paste Special

Microsoft Excel 2016 normally copies all the information in the range of cells you select when you paste 
the data. Use Excel’s Paste Special command to specify other options, such as pasting only the cell contents 
(without the formatting) or only the formatting (without the cell contents). Other options such as Paste 
Values – remove a formula and leave just the result and transpose which switches your data around.

9.2.1	 To use Paste Special

First copy the item that you want to use in a Paste Special.
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Figure 112 – Paste special options from the drop down

1.	 Go to the Home tab on the ribbon
2.	 Go to the Clipboard group
3.	 Click on the Paste button
4.	 Select from the icon choices depending on what you wish to do Or
5.	 Click on Paste Special at the bottom of the list and use the dialogue box that pops up
6.	 Select the type of Paste Special from the dialog box 
7.	 Click OK
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Figure 113 – Paste special options from the menu

9.2.2	 Which Paste Special option do I choose?

•	 All to paste all the stuff in the cell selection (formulas, formatting, you name it). This is what 
happens when you paste normally. 

•	 Formulas to paste all the text, numbers, and formulas in the current cell selection without 
their formatting.

•	 Values to convert formulas in the current cell selection to their calculated values.
•	 Formats to paste only the formatting from the current cell selection, without the cell entries.
•	 Comments to paste only the notes that you attach to their cells (kinda like electronic self-stick notes).
•	 Validation to paste only the data validation rules into the cell range that you set up with the 

Data Validation command.
•	 All Using Source Theme to paste all the information plus the cell styles applied to the cells.
•	 All Except Borders to paste all the stuff in the cell selection without copying any borders you 

use there.
•	 Column Widths to apply the column widths of the cells copied to the Clipboard to the columns 

where the cells are pasted.
•	 Formulas and Number Formats to include the number formats assigned to the pasted values 

and formulas.
•	 Values and Number Formats to convert formulas to their calculated values and include the 

number formats you assigned to all the copied or cut values.
•	 All merging conditional formats paste conditional formatting into the selected range
•	 Skip Blanks: Select this check box when you want Excel to paste only from the cells that aren’t empty.
•	 Transpose: Select this check box when you want Excel to change the orientation of the pasted 

entries. For example, if the original cells’ entries run down the rows of a single column of the 
worksheet, the transposed pasted entries will run across the columns of a single row.

•	 Paste Link: Click this button when you want to establish a link between the copies you’re 
pasting and the original entries. That way, changes to the original cells automatically update 
in the pasted copies.
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9.2.3	 Operations

When you paste, you can also perform some simple math calculations based on the value(s) in the copied 
or cut cell(s) and the value in the target cell(s):

•	 None: Excel performs no operation between the data entries you cut or copy to the Clipboard 
and the data entries in the cell range where you paste. This is the default setting.

•	 Add: Excel adds the values you cut or copy to the Clipboard to the values in the cell range 
where you paste.

•	 Subtract: Excel subtracts the values you cut or copy to the Clipboard from the values in the 
cell range where you paste.

•	 Multiply: Excel multiplies the values you cut or copy to the Clipboard by the values in the cell 
range where you paste.

•	 Divide: Excel divides the values you cut or copy to the Clipboard by the values in the cell 
range where you paste.

9.2.4	 Transpose Columns and Rows

Figure 114 – Transpose will allow you to change your mind about the layout
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Suppose you created a table of data and then realized that you would prefer it if the data was arranged 
a different way. Excel allows you to Transpose the columns to the rows and the rows to the columns. In 
the image above I switched the data around so that the years are in the first column instead of the top 
row and the months are along the top instead of the first column.

To do this:

1.	 Select the data to transpose including the headings
2.	 Click Copy
3.	 Click into a cell where you wish the data to appear (do not try and paste over the selected 

data as it will not work!)
4.	 Click the Drop down Arrow under the Paste Icon
5.	 Select the icon for Transpose or press T
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10	 Formatting Cells and Worksheets
10.1	 The Font Group

The Font group contains the main features you would want to use to change the appearance of 
your content.

10.1.1	 The Font Group

Figure 115 – The Font Group

1.	 Go to the Home tab on the ribbon
2.	 Go to the Font Group

10.1.2	 Bold, Italic and Underline

Figure 116 – Bold Italic and Underline

1.	 Select the cells you wish to format
2.	 Click on the icon you require

10.1.3	 Changing the Font 

Figure 117 – Change the font

1.	 Select the cells you wish to format
2.	 Click on the down arrow next to the font box
3.	 Select the font you require
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10.1.4	 Changing the Font size

Figure 118 – Change the font size

1.	 Select the cells you wish to format
2.	 Click on the down arrow next to the font size box
3.	 Select the font size you require

10.1.5	 Making more detailed changes

1.	 Select the cells you wish to format
2.	 Click on the Dialog box launcher arrow on the font group

Figure 119 – Launch the font dialogue box

3.	
4.	 Make the changes you require
5.	 Click OK

10.2	 The Alignment Group

Alignment signifies where your text/numbers will line up in a cell.

10.2.1	 The Alignment Group

Figure 120 – Alignment icons
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1.	 Go to the Home tab on the ribbon
2.	 Go to the Alignment group

10.2.2	 Setting the alignment in a cell

Figure 121 – Cell alignment

1.	 Click on the cell
2.	 Click on the icon you need:

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/academictransfer


Excel 2016 Core Part One

87 

Formatting Cells and Worksheets


10.2.3	 Orientation of text/numbers in a cell

You can change the direction of text in a cell or cells. Simply select the cells to change and then choose 
the orientation to suit.

Figure 122 – Text orientation within a cell

10.3	 The Number Group

Number formats allow you to change the appearance of your figures. For example, if your figures represent 
money, you can format them to appear with the pound sign and two decimal places.

10.3.1	 The number group

The Number group has shortcuts that allow you to apply a particular number format to selected cells or 
to add currency- which could be GBP, Dollars or the Euro symbol. Format a number as a percentage, 
add a thousand separator or increase and decrease decimals.

Figure 123 – The Numbers group
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10.3.2	 Applying number formats

To apply a specific number format, select the cell(s) and then click the drop down arrow and choose 
the format you want.

Figure 124 – Number formats from the drop down

10.3.3	 Removing number formats

Figure 125 – Remove a number format

1.	 Click on the cells you wish to clear the number formats from
2.	 Click on the Number Format drop down
3.	 Select the first option, General – No specific format

10.4	 Wrapping Text in a Cell

Text wrapping allows you to add more text in the cell, and the cell will then keep its width but 
automatically increase its height to accommodate the content.
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10.4.1	 To Wrap Text in a Cell

Text wrapping is useful when you have a heading or some text that is too wide for the cell. Text wrapping 
will move text to the next line and increase the depth of the cell to accommodate all of the text.

Figure 126 – Wrap text in a cell

1.	 Select the cell you want to wrap
2.	 Go to the Alignment Group on the Home Tab
3.	 Click on Wrap Text button 

10.5	 Format Painter

The format painter allows you to copy the formatting from one part of your workbook to another.

10.5.1	 To use the Format Painter once

1.	 Select the cell that contains the formatting you want to copy 
2.	 Click on the Format Painter button in the Clipboard group of the ribbon 
3.	 Click on the Cell (or Click and drag on the Cells) you want to apply the formatting you  

have copied to

Figure 127 – Format painter copies formatting

10.5.2	 Using the Format Painter to copy to more than one cell

1.	 Select the text that contains the formatting you want to copy
2.	 Double Click on the Format Painter button in the Clipboard group of the ribbon
3.	 Click and drag over the text you want to use the format you have copied
4.	 Click on the Format Painter button once again to switch it off
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11	 Merge or Split Cells
11.1	 Merging Cells

Type a heading into cell A1 and if it has more than a few letters, it appears to be sitting across several 
columns. However, when you click away and then place your cursor in cell B1 for example, you find 
that according to the formula bar, there is no text present.

You can merge cells together and control the alignment of the contents using the Merge Cell options.

11.1.1	 Merge and Centre

Figure 128 – Merge and Centre text 
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Select the cells you wish to merge – in this case I have selected cells A1 to D1 as I would like the heading 
to be centered across them. Click on the drop down next to Merge and Center Cells.
Select Merge & Center.

Figure 129 – Cells are merged and text is centered.

11.2	 Merge Across

11.2.1	 Merge Across

Figure 130 – Merge Across without centering 

Merge Across merges the cells but does not center the content.

11.2.2	 Merge Cells

Figure 131 – Merge cells together

This option merges cells together.
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11.2.3	 Centre across selection

When you merge cells together with or without centering the data, Excel treats the merged cell as one 
large cell. The issue with this is that if you need to perform calculations or sorting and filtering or any 
other programmatic function, the merged cells will get in the way.

To get around this, you can Center Across Selection which does not merge the cells but does center the data.

Select the cells you wish to Center Across

1.	 Click the dialogue box launcher in the Alignment group
2.	 Select Center Across Selection for the Horizontal alignment
3.	 Click OK

Figure 132 – Centre across a specific selection of cells

When merging cells that are not headings – Note: If you have content in more than one of the cells 
of your selection, the data in the upper-left cell is the only data that will be kept. All the other data 
will be lost.
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Figure 133 – When merging might not work!

If you have content in more than one of the cells of your selection, the data in the upper-left cell is the 
only data that will be kept. All the other data will be lost.

11.2.4	 To Align content within the Merged cell

Figure 134 – Align content within the merged cells

1.	 Select the Merged cell
2.	 Go to the Alignment group on the Home tab of the Ribbon
3.	 Click on the Alignment option you would like 
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11.3	 Un merge Cells

When you wish to remove the merged formatting do the reverse process.

11.3.1	 Un merge Cells

1.	 Select the Merged Cells 
2.	 Click on Un merge Cells

Figure 135 – Un merge cells
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12	 Headers and Footers
12.1	 Headers and Footers

Headers and footers appear on every printed page. This is how you add page numbers, date and time, 
the file name and path and where you can add a logo to every page in the Header.

Headers and Footers are added via the Page Layout View and are typed into the Header or Footer Area 
directly. A Header and Footer Ribbon will pop up when you begin.

12.1.1	 Change to Page Layout View

Figure 136 – Get to Page Layout

Click the Page Layout Icon – bottom right of the screen.

Or

Click on the View Tab and select Page Layout View from the icons there.

12.1.2	 Add a header

Once in Page Layout View click into the Header area.

Figure 137 – See the header/footer area
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The Header (and Footer) areas are divided up into three sections, Left, Center and Right. Click into the 
area you wish to have the Header (or Footer) appear in.

Once there a new Ribbon Tab Appears – Header and Footer Tools.

12.1.3	 Header and Footer tools ribbon

Figure 138 – Header and footer tools Ribbon

The Ribbon that pops up when you click into the Header area gives you various options to add to the 
Header or Footer.

12.1.4	 Pre-set Header or Footer

Figure 139 – Select from a pre-set header or footer

Choose one of the pre-set Headers or Footers and it will be added to the Header or Footer exactly where 
your cursor is.
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12.1.5	 Page Number

Figure 140 – Add page numbers

There are two icons for Page Numbers, Page Number and Number of Pages. If all you need is a simple 
page number, then select the first one.

If, however you want it to show for instance Page 2 of 4 then you need to

1.	 Type the word Page
2.	 Click on the Page Number Icon
3.	 Type a space then the word of then a space
4.	 Click on the Number of Pages icon

It will then say – Page 2 of 4.
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12.1.6	 Adding Header and Footer Elements

Figure 141 – Header and footer elements

•	 Current Date – this adds the current date to the worksheet header/footer and will always be 
up to date

•	 Current Time – like the current date this will always be up to date
•	 File Path – this adds the path and name showing where the file is saved – C\Documents\

ExcelBook\Coffee Sales for example
•	 File Name – this adds just the file name without the location
•	 Sheet Name – this adds the name of the current worksheet (assuming you have renamed it 

from Sheet 1)
•	 Picture – allows you to add a picture to the worksheet header
•	 Format Picture – having added a picture you can format it. This icon will only light up if 

you have a picture in the Header.

12.1.7	 Switch between Header and Footer

Figure 142 – Switch between the header and footer

Click the icon that will switch you between the Header or Footer.

12.1.8	 Options

Figure 143 – Header and footer options
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1.	 Different First Page – if your first page is a cover, you may not want to have the same 
Header or Footer as the rest of the pages

2.	 Different Odd and Even – when printing a report, you may want to have different odd and 
even paged Headers/Footers

3.	 Scale with Document – this keeps the Header/Footer in proportion if you scale down or up.
4.	 Align with page margins – this makes sure that the Header/Footer lines up with the margin. 

If you have a narrow margin you will want to tick this box so that the Header/Footer 
spreads out to meet the margin and is not inset.

12.1.9	 Current Date

The Current Date icon places the &[Date] field into the header/footer and shows the current date.

Figure 144 – Set the current date in the Header or Footer
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12.1.10	 Current Time

The Current Time icon places the &[Time] field in the Header/Footer and shows the current time as above.

Figure 145 – Show the current time

12.1.11	 File Path

The File Path places the &[File]&[Path] field into the header/footer – I am now using the Footer and it 
shows the file name and the path to the file – so you can find the spreadsheet when you need it

Figure 146 – Show the document path and filename

12.1.12	 File Name

T﻿his places the name of the current file in the Header/Footer – it looks like this &[File]

Figure 147 – Show the Filename on the sheet tab

12.1.13	 Sheet Name

This is the name of the worksheet – it looks like this &[Tab]

Figure 148 – Show the worksheet name 

12.1.14	 Picture

This is used when you wish to add a picture to your Header or Footer – either as a watermark or because 
you want to add a logo in the top right as in the image above.

Figure 149 – Add an image to your Header/footer
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12.1.15	 Format Picture

Figure 150 – Format the image 

This button only becomes available when you have a picture in your Header/Footer
Use it to change the size, crop, change brightness etc.

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

 

  

 

                . 

http://s.bookboon.com/AlcatelLucent


Excel 2016 Core Part One

102 

Printing Headings


13	 Printing Headings
13.1	 Print Titles

This is a very handy feature. There are times when you have a very long list and you would like the header 
to print on every page. You know, you print the list out and on pages 2,3,4 etc. it becomes impossible to 
see what the column headings are. Enter Print Titles.

13.1.1	 Print Titles

Figure 151 – Make your headings print on all worksheets

1.	 Click on Print Titles
2.	 Click into Rows to repeat at top
3.	 If you want to repeat a column or two select them as well in Columns to repeat at left
4.	 Click OK

Figure 152 – Headings will now print on all pages
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14	� Hide and Unhide Rows 
and Columns

14.1	 Hiding Columns

Just like worksheets, there are times when you may wish to hide Columns or Rows. In the Coffee Island 
Price List example, I have now worked out the Sales Price and want to show this to someone. I don’t want 
them to see the columns with the Profit Margin or the Cost Price. My aim is to use the one worksheet 
to show them just the Drink and the Sales Price.

14.1.1	 Hide Columns

1.	 Select the columns you with to hide – in my case B and C
2.	 Right click 
3.	 Click on Hide

Figure 153 – Hide a column

14.1.2	 Columns are now hidden

Notice that I now have column A followed by D – B & C have been hidden.

Figure 154 – Hidden column letters have been removed
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14.2	 Un hide Columns

14.2.1	 Un hide Columns

Figure 155 – Unhide the column

1.	 Select columns – here I selected A & D
2.	 Right click
3.	 Choose Unhide
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14.3	 Hiding Rows

In the same way that I can hide a column I can also hide a row or several rows.

14.3.1	 Hide a Row or Rows

1.	 Select the Row(s) you wish to hide
2.	 Right Click
3.	 Select Hide

Figure 156 – Select rows and right click to hide

14.3.2	 Rows are hidden

Figure 157 – Row numbers of hidden rows are missing

Rows 3 and 4 have been hidden.
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14.4	 Unhide Rows

14.4.1	 Unhide Rows

1.	 Select the rows either side of the ones you wish to un hide
2.	 Right Click
3.	 Select Unhide

Figure 158 – Unhide rows
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15	 �Page Setup Options 
for Worksheets

15.1	 Page Orientation

To change from Portrait to Landscape click the drop down and pick the setting you need.

Figure 159 – Change orientation

15.1.1	 Modifying page setup

We can change the way the page is set up; you might want different margins or to change from Portrait 
to Landscape.

15.1.2	 The Page Layout Ribbon

Figure 160 – The Page Layout ribbon

This is where you will come to change different aspects of the spreadsheet layout.

•	 Themes – this is where you can change the color scheme and fonts for the whole work book
•	 Page Setup – here you will change Margins, Orientation, Paper Size, Set Print Area, Add 

Page Breaks, format the background and set up Print Titles
•	 Scale to fit – you can change the width or height of the page and scale it up and down to 

make the contents fit on the printed page
•	 Sheet Options – View grid lines, View and/or Print Grid lines, View and/or Print Headings
•	 Arrange – if you have added graphics to the worksheet you can arrange how they behave on 

the page here.
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15.1.3	 Change the Margins

Click the drop down underneath Change Margins and select one of the presets. If you wish to set your 
own measurements for the margins, click on Custom Margins.

Figure 161 – Margins can be set from here 

15.1.4	 Custom Margins

Set the exact measurements you want for the Top, Left, Right and Bottom margins.

Figure 162 – Create custom margins 

15.2	 Changing the Header and Footer Size

15.2.1	 To change the Header and Footer size

1.	 Go to the Page Layout tab on the ribbon
2.	 Go to the Page Setup group
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3.	 Click on Margins 
4.	 Click on Custom Margins

Figure 163 – Set the header and footer margins here

5.	 Either type or use the up and down arrows to set the Header and Footer sizes
6.	 Click OK
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15.3	 Setting Print Scaling

Scaling your worksheet allows you to make all the data you have fit on one piece of paper, or as many 
as you specify. The upside is you get all your data on one sheet of paper, the downside is the text size 
will shrink and you might need a magnifying glass to read the spreadsheet.

15.3.1	 The Scale to fit group

Figure 164 – Print scaling on the Ribbon

Here you can try out different scaling options simply change the percentages in the boxes and see how 
your spreadsheet looks. To see how it will print, hop into Page Break Preview or click File and then 
Print to see the preview. You can set the scale to a total percentage here. If you would like more detail 
you can click on the dialogue box launcher in the bottom right of the group.

15.3.2	 Scale to fit dialogue box

Figure 165 – Use the scale to fit dialogue box too

1.	 Click the dialogue box launcher.
2.	 In the Scaling group of settings, you can tell Excel to make the data fit to 1 page wide by 1 

page high or any combination you wish.
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16	 Print a Worksheet or a Workbook
16.1	 Printing

Setting up your workbook to print is really simple. Add the print icon to the Quick Access Toolbar, or 
use the Print Menu or even the keyboard shortcut to print.

16.1.1	 What do I see when I click Print?

Figure 166 – The Print dialog

The Print Icon – click this to send your spreadsheet to the printer
Number of Copies – change how many printed copies you want here
Select the printer to send the job to – in my case I have my laser printer selected but it could easily be 
the color printer too
Select which sheets to print – If you have lots of data that will print on many sheets of paper, you can 
decide which pages you wish to print here. If you have several pages, do you want them collated or not? 
If you are printing more than one copy of a spreadsheet with several pages, select Collated.
Orientation – If you forgot to change the orientation from Portrait to Landscape before coming to Print, 
you can change it here.
Paper Size – Change the paper size here if you need to print to any paper other than A4
Custom Margins – Forgot to change the margins? Or perhaps the preview does not look quite right, 
you can change the margins directly from here.
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Custom Scaling – Set up scaling options here too
Page Setup – if you want to make lots of changes at once you can access Page Setup from here
The Preview – Print Preview has been combined with Print so you can see exactly how it will look 
Tells you how many pages there are and which one you are looking at.

16.2	 Printing individual worksheets

When it comes to printing in Excel there are several ways to print your data. You may wish to print just 
a selection of data, the current active worksheet or the entire workbook. Here is how to print just the 
active worksheet.

16.2.1	 Print Active Worksheet

1.	 Click File
2.	 Set the number of copies you want
3.	 Click Print

Note that in the Settings area it says Print Active Sheets.
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Figure 167 – Print active sheets if you only want the worksheet your cursor is on 

16.2.2	 To change the print settings

Figure 168 – Change the print settings here

Click the drop down list next to Print Active Sheets and make your selection

Print Active Sheets – this prints all the data on the current worksheet

Print Entire Workbook – this prints ALL worksheets in the current workbook

Print Selection – this prints only those cells which you have selected prior to clicking on File >Print

Ignore Print Area – If you have set a Print Area you may wish to now print the entire worksheet or a 
different selection of data, by ticking the Ignore Print Area instruction, Excel will ignore your Print Area 
settings and they will be there for next time.
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17	 Cell Styles
17.1	 Apply Cell Styles

Cell styles are pre-set formats for cells. They can be reused to help your sheet’s formatting look consistent.

17.1.1	 To apply a cell style

1.	 Select the cells you would like to apply a style to 
2.	 Go to the Styles group on the Home tab on the ribbon
3.	 Click on the Cell Styles button 
4.	 Click on the style you would like to apply

Figure 169 – Use pre-formatted cell styles

17.2	 Create Cell Styles

You can create your own Cell Style to allow you to rapidly format your workbook consistently.

17.2.3	 To create a cell style

1.	 Format a cell/some cells in the style you would like to add to Cell Styles 
2.	 Go to the Styles group on the Home tab on the ribbon
3.	 Click on the Cell Styles button 
4.	 Click on New Cell Style
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Figure 170 – Create your own styles

5.	 Give the style a name 
6.	 Un check any boxes that relate to styles you do not want to keep 
7.	 Click OK

Figure 171 – Name the new style 

If you want to change anything on the style before confirming, click on the Format button to bring up 
further options.
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8.	 Your custom style appears in the Cell Styles drop down menu under “Custom” 

Figure 172 – See the new style in the Cell Styles Gallery
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18	 Autofill
18.1	 Copy Data using Autofill

Auto Fill is a time saving feature that allows you to copy text, numbers or Formula in a spreadsheet.

18.1.1	 To copy data using auto fill

Figure 173 – Using Autofill – look for the little black plus sign

1.	 Type the content into the first cell.
2.	 Position the cursor so it hovers over the bottom right of the cell and it turns into a black cross 

Figure 174 – You can fill horizontally or vertically

3.	 Click and drag horizontally or vertically to copy the content

Figure 175 – Content is copied or a series is created

4.	 When you let go, the content is copied

If the content contains figures (or a possible series e.g. 1,2,3 or Monday, Tuesday, Wednesday)

5.	 A Smart Tag appears 
6.	 Click on the drop down arrow on the Smart Tag
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Figure 176 – To stop the series, select Copy from the Smart Tag options

7.	 Select Copy Cells from the Smart Tag options

18.2	 Fill Series using Autofill

Not only does Autofill help when copying data to adjacent cell, it can also create a series. So if you need 
to increment each cell by 1 just select the correct option from the SmartTag.

18.2.1	 To Fill Series data using auto fill

1.	 Type the content into the first cell.
2.	 Position the cursor so it hovers over the bottom right of the cell and it turns into a black cross 
3.	 Click and drag horizontally or vertically to copy the content
4.	 When you let go, the content is copied but each cell is incremented from the cell before (e.g. 

1, 2, 3 or Monday, Tuesday, Wednesday)
5.	 A Smart Tag appears 
6.	 Click on the drop down arrow on the Smart Tag

18.2.2	 Special Lists

Figure 177 – Use special lists to save time when typing 

Special Lists are regularly used items that have been pre-set by Microsoft. For example, you can auto fill 
days of the week, months of the year and dates.
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18.2.3	 To auto fill a special list

1.	 Type the first item of the special list
2.	 Auto fill as usual, horizontally or vertically

18.3	 Copy Formatting using Autofill

Auto Fill also allows you to copy formats from one cell to another.

18.3.1	 To copy formatting using auto fill

1.	 Format the content in your first cell.
2.	 Position your cursor so it hovers over the bottom right of the cell and it turns into a black cross 
3.	 Click and drag horizontally or vertically to copy – initially it will also perform a content auto 

fill so may overwrite the content already in the cells. Don’t panic, this is only temporary!

Figure 178 – Use Autofill to copy formatting 
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4.	 When you let go, the content is copied but, more importantly, the formatting is also copied.
5.	 A Smart Tag appears 
6.	 Click on the drop down arrow on the Smart Tag

Figure 179 – Choose to fill with or without formatting

7.	 Select Fill Formatting Only from the Smart Tag options
8.	 The content returns to its previous values, however, the formatting is copied across

18.3.2	 To fill without copying the formatting

Sometimes you might want to auto fill from a cell that is already formatted, in which case the formatting 
will also be copied.

To prevent the formatting being copied, auto fill as usual, then select Fill Without Formatting from the 
Smart Tag options.
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19	 Flash Fill
19.1	 Flash Fill

Flash Fill made its debut in Excel 2013. When you have data in a column and want to extract something 
or copy something, previously you would have used a formula. Excel 2016 will now do the heavy lifting 
for you. In fact at first when you see how it works, you might have wondered what on earth Excel was 
playing at and dismissed what is in fact a real time saver.

19.1.1	 Flash Fill to Join Two Columns

Figure 180 – Flash Fill will create magic lists 

In my example, I have a spreadsheet with names which have been entered as First Name and Last Name. 
I actually need to have a Full Name field. This can easily be achieved with a formula however most people 
don’t really like writing formula and you may well wish to strip out the formula once you achieved the 
result. This is yet another step.

Enter Flash Fill –

1.	 Type the result you want in the first cell
2.	 Type the result you want in the second cell so Flash Fill gets to really work out what  

you are doing
3.	 You will see the grey suggestions
4.	 If you like what you see, simply press the Enter key and that’s it!
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19.1.2	 Flash Fill to Extract Data

Figure 181 – Extract data with Flash Fill

I want to have the postcode in a separate column.

The process:

1.	 Type a heading and format it in the first cell (E1 in my example)
2.	 Type the first Postcode in the list 
3.	 Start to type the second Postcode
4.	 Excel now finds the pattern in what you are doing and Flash Fills the rest of the column!
5.	 Press Enter to accept.

19.1.3	 Flash Fill to Format Telephone Numbers

Figure 182 – Apply a pattern to data using Flash Fill 

I received this spreadsheet with telephone numbers typed in the Number Column without any spaces 
or hyphens. I would like the numbers to have hyphens in between each block of numbers.

1.	 Format the cells as Text – this makes sure that any leading 0 stays put and does not get dropped
2.	 Format the cells in the next column as text too
3.	 Type in the first telephone number in the format you want to use
4.	 Start to type the second one
5.	 The Flash Fill suggestions will appear
6.	 Click Enter to accept
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20	 Formulas
20.1	 Formulas Introduction

A Formula is the term used for a calculation in your spreadsheet.

A formula performs calculations or other actions on the data in your worksheet. A formula always starts 
with an equal sign (=), which can be followed by numbers, mathematical operators (such as a plus or 
minus sign), and functions, which can really expand the power of a formula.

For example, the following formula multiplies 2 by 3 and then adds 5 to that result to come up with the 
answer, 11.

=2*3+5

20.1.1	 Best practice: Using cell references in formulas

While this formula works, it has one drawback. If you want to change the data being calculated, you 
need to edit or rewrite the formula.

A better way would be to write formulas so that you can change the data without having to change the 
formulas themselves. To do this, you need to tell Excel which cell the data is located in. 

A cell’s location in the spreadsheet is referred to as its cell reference.

To find a cell reference, simply look at the column headings to find which column the cell is in, and 
across to find which row it is in.

The cell reference is a combination of the column letter and row number – such as A1, B3, or Z345. 

When writing cell references the column letter always comes first.

So, instead of writing this formula in cell C1:

= 3 + 2

write this instead:

= A1+A2

20.2	 How is a formula made up?

•	 Formula always start with the equals sign
•	 Cell references are used instead of numbers
•	 A mathematical symbol is used to denote the type of calculation
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21	 Create Formulas
21.1	 Add, Subtract, Multiply, Divide

The structure of a basic formula in Excel always follows the same structure:

•	 Equals Sign
•	 First Cell Reference
•	 Mathematical Symbol
•	 Second Cell Reference

21.1.1	 The Mathematical Symbols used by Excel

+ Addition

- Subtraction

* Multiplication

/ Division
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21.1.2	 To create a formula to add, subtract, multiply or divide

Figure 183 – Create a formula

1.	 Click on the cell where you require the answer
2.	 Type the = sign
3.	 Click on the first cell involved in your calculation
4.	 Type the math symbol you are using
5.	 Click on the next cell involved in your calculation
6.	 Repeat steps 4 & 5 (if you need to add more cells to your formula)
7.	 Press Enter

Figure 184 – See the result

8.	 The cell will then show the result of the formula

21.2	 Make Changes to Formulas in a Cell

To change a formula in a cell, double click on the cell and the formula will be revealed for you to edit 
as you wish.

21.3	 Make Changes to Formulas in the Formula Bar

When you select a cell that contains a formula, the cell displays the result of the formula but the formula 
can be seen in the formula bar.

Figure 185 – Use the Formula bar to see what is going on behind the result in the cell
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21.3.1	 To make changes to formula in the formula bar

1.	 Select the cell containing the formula you want to change
2.	 Click into the formula bar and make the changes you require
3.	 Press enter on the keyboard

21.4	 Using Autofill to Copy Formulas

If you have a table of data that all use the same calculation, it would be tedious to manually enter the 
formula again and again. So you can copy a formula using Auto fill.

21.4.1	 To copy a formula using auto fill

Figure 186 – Autofill formula

1.	 Create your first formula
2.	 Select the cell
3.	 Hover your cursor over the bottom right hand corner of the cell until you get the black cross (1)

Figure 187 – Horizontal or vertical – you can Autofill in either direction
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4.	 Click and drag in the direction you want to Auto fill

Figure 188 – The formula is copied

5.	 The formula is copied down and the results appear in the cells
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22	 Enforce Precedence
22.1	 Order of Evaluation (Order of Precedence) (BODMAS)

Calculations are not simply done from left to right. Below is the order in which all calculations 
are performed.

Priority Symbol Explanation

1 () Anything in brackets is done before 
anything outside the brackets

2 ^ Raises a number in order of magnitude 
to the power of something else

3 * / Multiply and divide are on the same 
level, whichever is the furthest left in the 
formula is done first

4 + - Plus and minus are on the same level. 
Whichever is furthest left in the formula 
is done first.

The acronym for this is BODMAS

Brackets Order Divide Multiply Add Subtract

So, for example, if I had the calculation:

=2+3*4

There are two possible solutions. If I add 2+3 and then multiply by 4 I would get an answer of 20.

However, in Excel the multiplication would be done first, because multiplication has higher priority than 
addition. So Excel would calculate the formula as:

3 multiplied by 4 and then add 2, to get an answer of 14.
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22.1.1	 To get Excel to calculate a formula in the order you would like it to

To get around the order of precedence, use brackets to separate the calculation you would like to be 
done first.

So in the example:

=2+3*4

If I want the 2+3 to be done before the multiplication by 4, I put brackets around the 2+3

= (2+3)*4

This way, Excel will calculate the formula in the order I want it to, rather than by following the Order 
of Evaluation.
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23	 Absolute Cell References
23.1	 Absolute Cell References

Using Auto Fill to copy formulas is a great way to save time, but the cell references in the original 
formula do not always need to be adjusted. There are some situations where a cell reference needs to 
remain constant. 

For example:

Look at the spreadsheet shown below – everyone’s salary is due to increase by 10%. The first formula, 
to find Barbara’s new salary has been created. Her current salary (in Cell B4) has been multiplied by the 
value in Cell C1, 10%. (0.1)

Figure 189 – Increase salaries 

The quickest way to work out everyone else’s increase is to copy Barbara’s formula. However, if the formula 
is copied using Auto Fill as it is, the row numbers will be incremented, including the cell reference for 
the 10% increase, and we’ll end up with some funny answers…

Figure 190 – Autofill goes wrong
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Here, Auto Fill has caused the row numbers to be adjusted. But the formula we need requires Cell C1 
to remain constant even when Auto Fill is used.

Excel must absolutely always look at this cell. In other words, we need to make it an absolute cell reference. 

Figure 191 – Autofill correctly with an Absolute Cell Reference

23.2	 How to Create an Absolute Cell Reference

23.2.1	 To input an absolute cell reference while creating a formula

Figure 192 – Use the F4 key to fix a cell reference with the dollar signs

1.	 Select the cell where you require the first formula
2.	 Enter the formula as normal
3.	 Press F4 after the cell reference you wish to be absolute (Dollar signs will appear around the 

cell reference) 
4.	 Press Enter
5.	 Auto Fill the formula

23.2.2	 To change an existing formula that needs an absolute cell reference

1.	 Click on the cell containing the formula you wish to change
2.	 Double-click on the cell (or Click next to the formula on the Formula bar)
3.	 Move the cursor so that it sits next to the cell reference you wish to make absolute
4.	 Press F4
5.	 Dollar signs will appear around the cell reference
6.	 Press Enter
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23.3	 Relative Cell References

An absolute cell reference is useful if you have one cell that needs to be completely fixed, but sometimes 
you need to only fix part of a cell reference.

This is known as a relative (or partial absolute) cell reference.

23.3.1	 Glossary of Relative Cell References

$A1 Allows the row reference to change, but not the column reference

A$1 Allows the column reference to change, but not the row reference

$A$1 Allows neither the column nor the row reference to change.

23.3.2	 To add a Relative Cell Reference (Partial Absolute)

1.	 Type your formula
2.	 Place your cursor next to the reference you want to make a Partial Absolute
3.	 Press F4 on the keyboard – the cell becomes Absolute (e.g. $A$1)
4.	 Press F4 again – the reference becomes a Partial Absolute fixing the row (e.g. A$1)
5.	 Press F4 again – the reference becomes a Partial Absolute fixing the column 
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24	 Basic Functions
24.1	 Basic Functions

There are certain useful calculations that become long winded if you try and create them with 
straightforward formula.

For example, a calculation such as finding the Average of a group of numbers could be complicated to 
write if you were to work it out for yourself.

Similarly, if you have 300 items that you want to add up, it would be tedious to write a long formula 
with 300 calculations.

So Excel has the ability to use functions. These are specially programmed formulas that allow you to 
perform these more complicated calculations much more easily.

24.1.1	 The structure of a basic function

Because functions are so varied, the details of their construction are unique. But they all follow a similar 
basic structure.

They begin with an Equals sign, followed by the Name of the Function, then the details of the function 
in Brackets.

For example:

=Average(B3:B6)

The content between the brackets will be different depending on the Function being used.
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24.2	 Using Basic functions via the Auto sum Button

The Auto Sum button contains five commonly used basic functions. These are SUM, AVERAGE, MAX, 
MIN and COUNT.

24.2.1	 SUM, AVERAGE, MAX, MIN and COUNT Numbers

Figure 193 – Excel has some regular functions available from the AutoSum button

24.2.2	 To use a basic function using the Auto sum button

1.	 Click on the cell where you require the answer 
2.	 Go to the Editing group on the Home tab on the ribbon
3.	 Click on the Auto Sum drop down button 
4.	 Select the function you require

Figure 194 – Sum a column using AutoSum

5.	 The cells Excel thinks you want to calculate will be highlighted and the Function will appear 
in the cell – If Excel hasn’t selected the cells you want, click and drag over the ones you do 
want to include

6.	 Press Enter
7.	 The answer will be shown in the cell
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25	� Managing Worksheets 
and Workbooks

25.1	 Introduction Worksheets

Excel files are called workbooks and just like any book they can contain several worksheets. 

To begin with you will have just one worksheet, but you can add as many as you need.

25.1.1	 Why have more than one sheet?

Imagine that you have to store information about your organization’s budget over five years. If you try 
and put all this onto one sheet, it will become so vast that it will be almost impossible to navigate through 
and find the information that you require. If you set up similar sheets for each year or even for each 
month, then it becomes a lot easier to find the information you are looking for.
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26	 Create and format worksheets
26.1	 Adding worksheets to existing workbooks

Sometimes you will find that you need more worksheets than are available in the workbook. Perhaps 
you are creating a summary worksheet or you want to keep track of different things on different sheets.

In Excel 2016 it is very simple to add a new worksheet to the workbook – here is how.

26.1.1	 Add a new worksheet

Figure 195 – Add a new worksheet

Click on the plus sign next to Sheet1 and you will get a new worksheet.

26.1.2	 New worksheet added

Figure 196 – New worksheets are numbered

Keep adding sheet tabs until you have as many as you need.

26.2	 Delete Worksheets

Figure 197 – Delete a worksheet

The easiest way is to Right Click on the sheet tab and select Delete
The worksheet is deleted immediately.
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26.3	 Copying and moving worksheets

When working on the structure of your workbook, you may realize that you need another copy of a 
particular worksheet in the same workbook or you might want to move or copy the worksheet to another 
location in the workbook or even to another workbook entirely.

26.3.1	 Move a worksheet within the workbook

Figure 198 – Drag a worksheet to a new position within the workbook

Click and drag on the sheet tab to move it – you will see a little image of a page – drag this to the location 
you wish to place it.

26.3.2	 Copy a worksheet within the workbook

Figure 199 – Create a copy of the worksheet within the workbook

1.	 Right click on the worksheet tab
2.	 Select Move or Copy Sheet
3.	 Tick Create a copy 
4.	 Select where you want to place the copy
5.	 Click Ok

26.4	 Rename a Worksheet

You can name the worksheets to make your work more meaningful. Instead of Sheet 1, Sheet 2, Sheet 3 
you can have January, February, March or whatever name you wish.
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26.4.1	 Rename a Worksheet

Figure 200 – Rename the worksheet

1.	 Double click on the sheet tab to highlight the current name 
2.	 Type your name and then click away to confirm.

26.5	 Grouping Worksheets

When sheets are grouped together, whatever you do on one sheet will “burn through” to all of the other 
sheets in the group. It’s useful when you are going to have several sheets in a workbook that do virtually 
the same thing. For instance, you might be creating a budget over several months, and each month has 
its own sheet. With sheets grouped you can:-

•	 Apply formatting to all of the sheets in the group at once
•	 Create formula on all of the sheets in the group at once
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26.5.1	 To group worksheets that are next to each other

Figure 201 – Group worksheets together to add the same information to all 

1.	 Click on the first Sheet tab that you require
2.	 Hold down the Shift key
3.	 Click on the last Sheet tab that you require
4.	 The Sheet Tabs of the sheets that are grouped will turn white if not colored and go pale if 

they have color applied

26.5.2	 To group worksheets that are not next to each other

Figure 202 –Use the Control Key to group worksheets that are not next to each other

1.	 Click on the first Sheet tab that you require
2.	 Hold down the Control key
3.	 Click on any other Sheet tabs that you require
4.	 The Sheet Tabs of the sheets that are grouped will turn white or go pale

26.6	 Changing worksheet tab colour

When you have many worksheets, it can be helpful to change the tab color so that the one you want is 
easy to recognize.

26.6.1	 Change tab colour

Figure 203 – Right click to change the tab color

1.	 Right Click the Worksheet tab
2.	 Click on Tab Color
3.	 Choose the color from the color palette
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26.7	 Hiding worksheets

At times you may wish to hide an entire worksheet in a workbook. For example, at Koffee Island we are 
working out the sales price of the various drinks we sell. Multiply the cost price by the profit margin 
and then add up the total price that we sell the coffee for.

When showing this workbook to a customer for example, we might not want them to see the percentages 
on the Variables worksheet. So this worksheet can be hidden. Any calculations will still work; the data 
will simply be hidden from view.

26.7.1	 Hide a worksheet

Figure 204 – Right click to hide a worksheet 

1.	 Right click on the tab of the worksheet you wish to hide
2.	 Select hide

26.7.2	 To Unhide the worksheet

Figure 205 – Right click to unhide the worksheet

1.	 Right click on a worksheet tab
2.	 Select Unhide
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Figure 206 – Choose which worksheet to unhide – you may have hidden more than one!

3.	 Click on the worksheet you wish to unhide
4.	 Click OK

26.8	 Sum across Worksheets

When you have a workbook with several worksheets you will need to sum across sheets. When data is 
dispersed use the simple way of creating a formula however if you have created a workbook with the 
same structure on each worksheet, you can sum across all the sheets at the same time.
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26.8.1	 Add Up Data from More Than One Worksheet

Figure 207 – Sum across worksheets 

1.	 Click in the Summary worksheet where you want the answer – in this example cell B4.
2.	 Type an = to signal to Excel that you are going to calculate
3.	 Click on the Sheet tab called January 
4.	 Click into cell B4 on the January Worksheet
5.	 Press the + sign
6.	 Click on the February Worksheet
7.	 Click on Cell B4 on the February Worksheet
8.	 Press the + sign
9.	 Click on March

10.	 Click on Cell B4 on the March Worksheet
11.	 Press Enter

Note the formula =January!B4+February!B4+March!B4

The ! after the sheet tab name indicates to Excel to refer to the sheet of that name.

Just keep on adding in cells until you have everything you need.

26.8.2	 Sum Across Sheets When the Structure is The Same

Figure 208 – Sum across worksheets when data is in the same cell 
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This time because we created a workbook with a group of worksheets with the same structure, we can 
use a Sum together with Grouping the sheets to add them all up.

The formula here tells Excel to go to the Worksheets January through March and add up the contents 
of Cell B4.

1.	 Click into the cell where the answer will go
2.	 Type =Sum(
3.	 Now you need to group the other worksheets, so click first on January then hold down the 

Shift Key and click on March – this groups all worksheets between January and March
4.	 Then click on Cell B4
5.	 Close the Brackets and press Enter
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27	 Manipulate window views
27.1	 Splitting the window

At times you may be working on a huge worksheet. It can be very time consuming and tedious to scroll 
up and down and right to left to work on different parts. When you Split the worksheet into Panes, you 
can scroll them independently and work on them, and still be in the same worksheet.

27.1.1	 Split a worksheet

Figure 209 – Split the worksheet into panes

1.	 Click into the worksheet where you want to split the worksheet
2.	 Click on the View tab
3.	 Click the Split button

The worksheet will split above and to the left of where your cursor is.
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27.1.2	 Scroll in different parts

Figure 210 – Scroll the sections independantly

You can now scroll in the top or the bottom half.

27.1.3	 Remove the split

Figure 211 – Click the Split icon to remove the split

1.	 Click on the View tab
2.	 Click on Split

The split will now disappear.

Download free eBooks at bookboon.com



Excel 2016 Core Part One

146 

Manipulate window views


27.2	 Open Two Copies of the Same Workbook

When working on a workbook that contains many worksheets, there are times that you need to see two 
worksheets at the same time. Imagine that you have a summary worksheet and you need to see the effect 
of making a change on one of the spreadsheets that feed into it. 

You can open a second copy of the workbook in a new window and then arrange the windows side by 
side so that you can see the January worksheet in one window and the Summary worksheet in the other. 
Now whenever you make a change to the January worksheet you will be able to see the effect on the 
Summary. I have to say that this is one of my favorite features.

27.2.1	 Create a Second Window in the Same Workbook

Figure 212 – Create a second copy of a workbook
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Here is my workbook – it is called Summary Workbook – Excel

Click on New Window (1)

Figure 213 – A new copy opens in a new window

I now have Summary Workbook:2 – Excel
Click on Arrange All (1)

27.2.2	 Arrange the Workbooks

Figure 214 – Arrange the workbooks side by side – vertically 

Now select the way you wish to see the worksheets arranged. I have selected Vertical and ticked Windows 
of active workbook. I don’t want to arrange any other workbooks I may have open too.
Click OK
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27.2.3	 Two copies side by side

Figure 215 – See both copies side by side and work on different worksheets in each

Now I have two copies of the same workbook open, Summary Workbook:1 and Summary Workbook:2 
In one I have the January worksheet open and in the other I have the Summary Worksheet open
Now any changes that I make to January will show in Summary.
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